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CHAPTER 1

Introducing ArckExplorer

Welcome to ArcExplorer™ software, a Windows desktop application for
downloading, viewing, and examining spatial data. ArcExplorer works

on its own with data sets stored on your PC or local network. When
connected to the Internet (or an intranet), ArcExplorer also becomes a
Web client capable of browsing and downloading vector data in industry-
standard shapefile formats. You can then disconnect ArcExplorer and use
the data in local (stand-alone) mode.

ArcExplorer is intended to serve a very simple purpose: to view and

guery geographic information system (GIS) data. The software includes
useful query and symbolization tools for exploring your data and creating
interesting maps. If you want to perform complex spatial queries, add
information from other tables, geocode (locate street addresses on a map),
interactively label features, and more, ESRI provides powerful products
that answer your needs. To get information about products like

ArcView® GIS and ARC/INFO® software go to ESRI's Web site
(Www.esri.com), call 1-800-GIS-XPRT, or contact your nearest ESRI
regional office or distributor.



What you can do with ArcExplorer

Asa stand-alone desktop application, ArcExplorer isacomplete, easy-to-use GIS data
viewer. With ArcExplorer you can

« View and query ESRI® shapefiles, ARC/INFO and PC ARC/INFO® coverages,
and Spatial Database Engine™ (SDE™) layers

« Locate, identify, and query geographic and attribute data

*  Create thematic maps from attributes in the database with powerful symbolization
tools

* Navigate your spatial data with pan and zoom tools

* View image file formats, including Windows Bitmaps, TIFFs, ERDAS, Sun
Rasterfiles, and others. (For the complete list of supported image formats, see the
list on page 33 of this document.)

With ArcExplorer connected to the World Wide Web, you can also
* View and query GIS data published on Web sites

« Download vector data (in shapefile format) from enabled Web sites to store locally
and use as GIS data in ArcExplorer or in any other ESRI GIS software product

Installing ArcExplorer

ArcExplorer is built with 32-bit MapObjects™ technology. Therefore, to use
ArcExplorer, you must have Microsoft Windows 95 or Microsoft Windows NT 4.0 (or
later) installed on your system. The tables below provide minimum and recommended
system requirements for running ArcExplorer.

Minimum Requirements

System Feature Windows 95 Windows NT 4.0 or later
System RAM 8 MB 12 MB

CPU 486DX 33 486DX 33

Video Adapter VGA VGA

Free Disk Space 5MB 5MB
Recommended

System Feature Windows 95 Windows NT 4.0 or later
System RAM 16 MB or better 16 MB or better
CPU Pentium 60 or better Pentium 60 or better
Video Adapter PCI Video Card PCI Video Card
Free Disk Space 10 MB 10 MB

Note: As with most Windows software, performance will improve with more memory
and faster systems.




Whether you got ArcExplorer on a CD or downloaded the file named aesetup.exe off the
Web, youingtall it by double clicking aesetup.exe and following the on-screen
instructions.

ArcExplorer is built with ESRI’s MapObjects, so if you're using any version of that,
either reingall it onto your system or reregister al componentsin the installation
directory. (The default location of the MapObjectsingallation directory is c:\program
files\esri\mapobjects.)

During the install procedure, you'll be prompted to select the type of installation you
want. The following table describes the three options:

Setup option Installation components

Typical Program will be installed with the most common options. Recommended for
most users.

Compact Program will be installed with the minimum required options.

Custom You choose the components you want to install. Recommended for advanced
users.

Select Components [ %]

Select the components you want to install, clear the components
you do not want to install

LComponents

Help and Tutnrl Filez
Sample Files
Internet Client 83K

Destination Director

(C:\Program FileshE SRIMArcExplorer Browse... | ‘
Space Required: 10203 K e
Space Available: 191280 K —IIS SR

< Back I Mexst » I Cancel |

After you've selected an option, click finish to accept the license agreement and follow
the on-screen instructions to complete the setup.

Double click the ArcExplorer Icon or choose ArcExplorer from the Start menu to launch
the program.

Getting help and technical support

In addition to this document, ArcExplorer also features an extensive online help system.
To access it, pull down the Help menu from the menu bar and choose Help Contents,
Search Help, or ESRI Web Resources.

You can also find a discussion forum at ESRI's Web site. Here you can post questions
and answers on the forum. See the ArcExplorer home page for links to the discussion
forum (http://www.esri.com/arcexplorer).

ESRI will maintain a current, updated version of this document's troubleshooting and
FAQ sections. Look for links to these documents at the ArcExplorer home page.

CHAPTER 2



Loading data

Y ou can use ArcExplorer to view locally stored GIS dataor to retrieve

GIS data over the Internet or an intranet. ArcExplorer has two modes for

loading data: Local and WWW. Use the ArcExplorer Local mode to

access data stored on your computer's hard disk drive, CD—-ROM drive, or
other computers connected to your computer via a local or wide area
network. Use WWW mode to get to data stored on Internet (or intranet)
servers that use WWW protocols. The labeled tabs found in the
ArcExplorer Table of Contents allow you to switch from Local to WWW
mode and back.

Adding locally stored data to an ArcExplorer project

When not connected to the Internet or an intranet, ArcExplorer functions as a stand-alone

data explorer. ArcExplorer can access data from your computer’s hard or floppy disk

drives, from a CD—ROM drive, from computers connected to your machine over a local
or wide area networks, or from SDE servers.

To add locally stored data to an ArcExplorer project

1. From the File menu, choose Add Theme, or click the Add Them®dolaccess
the Add Themes dialog box. ArcExplorer will list all the network connections on
your machine Pressthe escape key at any timeto halt this process.

Y Add Theme(s) = E3
All ArcE rplorer Types - ‘ | + | By T %| Add Theme  Clase ‘
[Folders [Themes

1 2 SKAGEN Name [ Tvpe [ Siee
=D Floppu [A:4)
-Q Lacal Disk [C:N)

[#-&=2 Removable Disk [D:4)
B EY

=2 melioD on metro [F:4)
=2 popl onfall [G:4)

=2 webmisc on thebos [H:\)
-Q reesed on fall [1:4)
52 esrid on fall {):5)

-5 public on turba [K:4)
(-2 saagar3 on fall (LY

2} Netwiare or Compatible Network
2 Microsoft wWindows Network
B SDE Server

Ready 4

2. From the Data Type drop down menu, you can select a specific type of ArcExplorer
data (shapefile, ARC/INFO coverage, image files, ZIP archives containing only
shapefiles) or just show all the supported data types (the default setting).



3. Navigate the directory structure as you would any Windows directory to the folder
where your GIS datais stored. (If you filtered for a specific type of datain the
previous step, ArcExplorer will show just those types of data.)

BY Add Theme(s] [_ (O] %]
Al ArcEsplorer Types - | | +
[CiesmMESRIDATANISAY
B AY_GIS30
{10 AvDLOG :
-0 ESRIDATA [EICOUNTIES SHP Palygan 1482KB
- CANADA EACITIES. SHP Pt S6KE
{0 MEXICD T ADLSHP
=3 SATABLES ROADS SHP Line 245KB
ROADS_RT.SHP Li 197KB
-] WORLD & e -
3 finaloanh LAKES.S
D_g |::t§:rb“ [ Rivers.shp Line 104KE
Ed DRAINAGE SHP Line BIKE
- MAKERS ! "
-0 MARKETPE Ezu)_usa.shp Paint 1144KR
{1 mcacfes
L1 MCR_shats
(1 peterkentbook
-] Program Files
#-0 PSFONTS
@ PSFONTS =
Ready i

4. Highlight one or more locally stored files that you wish to load and click Add
Theme. (Alternately, you can drag and drop thefile into the ArcExplorer Map
View, or smply double click thefile name.)

5. Navigate to another directory to add additiona themes, or click Closeto dismissthe
Add Themesdialog. The themesyou selected will appear in the ArcExplorer Table
of Contents.

Connecting ArcExplorer to an SDE database

ArcExplorer recognizes data stored in an ESRI SDE theme.

To connect to an SDE database

1. Manually edit your Windows Servicesfilein Notepad to include the name of the
SDE server you plan to connect to. (Consult with your SDE Database administrator
if you're not sure how to do this.)

o+
2. Inthe Add Themesdialog box, click the Add SDE button _5BE | to bring up the
connect to SDE L ogin window:

SDE Login

Server W
Instance: Iesri_sde—
Uszer: W
Pazsword: I’“1—

v SDE 3.0

Connect I Wiseariesh |

3. Enter the name of the SDE Server, Ingance, User name, and Password.

4. PressConnect. (Uncheck the SDE Version 3.0 check box if the SDE databaseis
Verson 2.X.)




Navigate the directory structure to the SDE server icon and open it. Select database.
Navigate through the directory to select the themes you want to add.

Press Add Themes. The themes from the SDE database will appear in the Table of
Contentsjust like any locally stored themes.

Accessing data off the WWW with ArcExplorer

ArcExplorer WWW access assumes that you have avalid Win32 I nternet connection.
ArcExplorer will make aconnection using the default parameters as defined in the
Windows Registry by the WWW provider software.

ESRI currently has one site that ArcExplorer can access, and more coming. The URL
(Universal Resource Locator) to usein your connection is
http://nutria.esri.com/scripts'esrimapc

To add an ArcExplorer Web site
1. IntheTable of Contents, click the tab labeled WWW.

2. From the File Menu, choose Add Theme, or click the Add Themetool ﬂ to access
the Add ArcExplorer Web Site dialog box.

Add an ArcExplorer Web Site

Enter an ArcExcplarer Enabled Wwiwhs/ site

[http:/ fnutria. e, com/soriptedesnimape)
Cancel |

3. Typeinthe URL of the Web ste youwish to add. Refer to the ArcExplorer home
page (http://www.esri.com/arcexplorer) for information on how to set up your own
map server using ESRI Internet Map Server technology.

< ArcExplorer [Pre-Release] - Untitled
FEile  Edt View Theme Took Help |

MEEIEREEIEEEE
dliaame|let oy

Local | www |

¥ PLACES [MD]
¥ INTERSTATES [MD)
[ OTHER COUNTRIES
¥ STATES [MD)

jc) 1997 ESRI Inc,

| Request Complete | sctive Theme: COUNTIES A

4. Thename of the server will show up under AEWeb. Navigate through the directory
of available GI'S data and double click those themes you want to add to the Explorer
view. A Table of Contentslisting all the Web-based themes will appear below the
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directory. Usethe black and gray arrowsto scroll through the list if it extends
beyond the Table of Contentswindow. Likeathemeinal ocal Table of Contents, a
WWW theme can a so be made active.

Downloading vector data from a Web site

1

Use the Pan and Zoom toolsto display the areayou wish to download. By defaullt,
ArcExplorer will download only the data showing in the Map View. ArcExplorer
will download datafor al the themesin the table of contents, aslong asfeatures
exig in the chosen extent. Each theme will be downloaded as a separate shapefile.

Once you are satisfied with the extent, click the Retrieve Vector Data tool é to
bring up the Retrieve Options dialog box.

Retrieve Options |

From the lizt below, select the amount of data to retrieve.

Select our Extent

% The cument extent """ Hetrleve
O ottt | e
™ 4 the extent Cancel

Select the extent of vector datayou want and press Retrieve.
Accept the License Agreement (if applicable).

Choose (or create) the folder where you want the shapefiles to be stored, and press
Open.

ArcExplorer will now start downloading the data. Y ou can halt the download at any
time by clicking the Cancel ﬂ toal.

Once ArcExplorer has finished downl oading the shapefilesto your local drive, you
will be asked if you want to add the vector datato your local view. If you choose No,
the shapefileswill till be stored at the location where you specified. If you choose
Y es, ArcExplorer will automatically toggle to the local table of contentsand list the
new themes. At this point you can change the display characteristics, perform finds
and queries, or anything else you can do with locally stored vector data.
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CHAPTER 3

Exploring the user interface

AI‘CEXp|Orer window _> < ArcExploter - The World
Menu bar ——— Fie Ecit Yiew Theme Tooks Help

s

Tool bars > sE-aanietssonsy
Local | wiwiw |

Table of I |

contents >

(legend)

Map View

Scale Bar

Cursor position

Overview Map ————— P> [eott conomene
p =:-16.3042 RF Scale: e Centimeter = 1040 Km
Y. 22301 1:104,301926 _ o0

Status Bar ———P  The'word Saved successfulll | Asctive Theme: CNTRY34 4

ArcExplorer window: The complete application interface.
Menu bar and Tool bars: Used to access dl the functions of ArcExplorer.

Table of contents: Displaysall thelayers of data asthemes. Usethe WWW tab to
access Internet data. The Table of Contents also serves as alegend describing the data.

Map View: Wherethe map draws. ESRI shapefiles (fileswith the .shp extension) can
be dragged and dropped straight from a Windows directory into aMap View.

Scale Bar: Displaysthe scale of the current Map View.

Cursor position: Showsthe position of the cursor on the Map View inthe
geographic coordinates of the data source.

Overview Map: Displaysamap showing the full extent of your data, with ared box
showing the area displayed in the Map View.

Status Bar: Shows context-sensitive help messages on the left and the current active
theme on theright.
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The ArcExplorer Table of Contents

The ArcExplorer Table of Contents lists al the themesthat you currently have loaded
into your Map View. The Table of Contents has two modes: Local for managing locally
stored databases and WWW for managing data stored on Web stes. The functions
described below work the samein either mode, unless stated otherwise.

From the Table of Contentsyou can

* Click the check box to the left of each theme’s name to make the theme draw in the
Map View.

Make a theme active by single clicking its name in the Table of Contents. (Making a
theme active tells ArcExplorer which theme you want to work with.)

Change the drawing order by using the left mouse button to drag themes up and down
within the Table of Contents.

Double click a theme’s hame to bring up the theme properties dialog box (Local mode
only).

 Use the tiny black and gray arrows to scroll the Table of Contents up and down if there
are more themes loaded than can be shown.

Right click a theme’s name in the Table of Contents to bring up the following theme-
specific menu choices (Local mode only):

Local | whwiw |

¥ STATES
[T <487.142.00 *. 4dd Theme Cirl+
[T 487.142.00- ¥ 4dd SDE Theme Cil+S
I_ B.533.456.00 - 7 Remave Theme

13,173, 770.00 - i i =
= 15 o6 B4 00 nght.cllck ona Er T -
T | t_ll_.leg:e "fl éhe |t.OCta| ¥ Foom Previous
v CHTHRY34 able of Contents
e I_ | > Uze in Owerview Map

|7 Dizplay Thematic Legend
i Blean Thematic Hendering

Move Theme 4

Set Minimum Scale Factor
Set Mawimum S cale Factor
Remove Scale Factars

Theme Properties
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Setting the map display properties

Y ou can control the background color, map outline, scroll bars, and other characterigtics
of your Explorer view.

To change the map display properties of your view
1. Choose Map Display Properties from the View menu.

Map Display Properties
— Set background color, — tap border style:

- - I_ - IU -Mone j
I_ I_ I_ I_ Eanpel actior?jwhen Escape
ey iz preszed:
I_ - I_ I_ |1 -Stop drawing all layers 7|
| I
crollbars on map

Selection Caolor I ¥ 30 appearance

2. Click acolor from the set of colored boxes to change the background color of the
Map View.

Choose a Selection Color. Featuresfound in a query will draw in thiscolor.

Select aMap Border Style. Thistogglesthe Map View border on and off. Itismost
noticeable in 3D mode.

5. SettheEscapekey. You can setit to stop drawing al layers, to stop drawing the
current layer, or to do nothing.

6. Click the check box Scrollbars on map if you want the Explorer view to include
scroll bars a the edge of the map for panning. (This option has no effect on the
standard pan and zoom tools.)

7. Click the check box 3D appearance if you want the Explorer view to have adightly
raised effect.
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Creating MapTips
MapTips are smdl, pop up windows that display the datafor a specified field asyou
move the cursor over the features of an active theme.
To create MapTips for atheme

1. Makeatheme active by clicking its namein the Table of Contents.

2. Click the MapTipstool E to bring up the Map Tips dialog box.

MapTip Field Selection ]|

Layer: ae_world Select a field to use

for the MapTip.

EIR_RATE
BIR_RATERD ak.

DOUELETH
DOUELETKA0 Cancel
DTH_RATE

DTH_RATEROD

EMERGY_BaL Clzar
Featureld ;I

3. Sdect thefidd you want displayed in the Map Tip pop up windows.
4. PressOK.

Working with scale

Each time you zoom in or zoom out in a view or resize a view's window, the view's scale
changes. ArcExplorer reports this change in the scale bar. To see the scale, add a scale
bar to the Map View by picking Display Scale Bar from the View menu. Right click on

the scale bar to open the Map, Scale, and Screen Unit controls.

One Inch = 40 miles

1: 24,000
m 10 20 ] 40

The scale bar consists of a representative fraction (1:24,000), a rule with distance

markers, and an equation (One inch = 40 miles). The fraction (RF scale) is a common
way to present scale in cartography and can be read as "one inch on the screen is equal to
24,000 inches on the ground." The equation (sometimes referred to as a "verbal scale")
presents the same information but translates the single unit (an inch in this example) into

a unit you'd use when getting around in the real world (miles). The same applies to
centimeters and kilometers.

Map units

Map units are the units geographic data is stored in. Because there are a variety of data
collection and storage methods, it is impossible for the ArcExplorer software to
determine exactly which type of map unit is used with your data. Because of this, you
must select the proper map units for accurate scale bar measurements. ArcExplorer

15



defaultsto decima degrees but this could be wrong and will provide erroneous results on
the scale bar if your datais stored in feet or meters. If you don't know the map unitsfor
your GI S data, read your data documentation or speak to the person who gave you the
data. If you can't find this information, you can zoom into a familiar area and try all
three map units until you get one that seems to provide the most accurate results.

Scale units

Scale units display in the scale bar itself and in the right side of the verbal scale equation
(1 centimeter = 20Rilometers, for example).

Screen units

Screen units correspond to the actual display on your computer monitor and are presented
in the left side of the verbal scale equatiom¢h = 40 miles). You can set the screen

units as either inches or centimeters. Right click on the scale bar to bring up the screen
units control.

Scale bar accuracy and projections

The geographical data you'll be using with ArcExplorer will be stored either as unprojected (or
‘geographic’) or as projected. Either way, the data is a two-dimensional representation of three-
dimensional reality, which means that the spatial properties of area, shape, direction, and distance
will be distorted to a greater or lesser extent.

As a consequence, the scale bar is not a precision tool. It is provided only to give a general sense of
distance. If your data is unprojected (in decimal degrees), the scale bar will be more accurate in the
center of the extent than on the edges. If your data is projected, the scale bar will only be as
accurate as the projection is. If the projection distorts distance (in order to preserve area, say), then
the scale bar will reflect that distortion.

The accuracy of projections, and of the scale bar, also changes depending on where you are on
your map. In a Mercator projection, distance measurements will be more accurate near the equator.

To find out more about projections, which spatial properties each preserves, and which each
distorts, see the following:

Elements of Cartography, by Arthur Robinson, Joel Morrison, and Phillip Muehrcke.
Sixth edition. John Wiley & Sons, 1995.

How to lie with maps, by Mark Monmonier. Second edition. University of Chicago
Press, 1996.

Introduction to Map Projections, by Porter McDonnell. Second edition. Landmark
Enterprises, 1991.

Map Projections. ESRI, 1994,
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Setting scale factors

Y ou can a'so control the scale at which atheme displays by setting the scale threshold for
it. For example, you could set US State boundaries theme to turn itself off after you
zoom past a certain point, and set the county boundariesto turn themselves on at this
same scale. Setting up scd e dependencies can help keep the display clean and focused
on relevant data

To set the Minimum and Maximum Scale Factor for atheme
1. Usethezoom toolsto set the scale point a which you want atheme to display.

2. Makethetheme active by clicking its namein the table of contents.

3. Right click on the theme’s hame and choose Set Minimum Scale factor if you want
the theme to turn off if you zoom any closer. Select Set Maximum Scale factor if
you want the theme to turn off when you zoom further out.

Note: You can right click a theme’s name and choose Remove Scale factors to remove
any scale factors previously set for that theme.
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Working with the Overview Map

The Overview map window shows you thefull extent of your data set with abox drawn
over the current extent.

How to create an Overview Map

1. Choose Overview from the View menu to create a blank window in the lower left-
hand corner of the application.

2. Topick aThemeto appear in the window, sdect Usein Overview from the Theme
menu, or hold down the Control key while using the right mouse button to drag and
drop the theme directly into the overview window.

Tip: A third way to specify atheme for the Overview Map isto right click on atheme
and choose Usein Overview Map from the list.

& ArcExplorer - Untitled
File Edit View Theme Tool: Help |

Lo aaietdsn oy

Local | whww' |

—

v CNTRv34 |

hiad

e comaTI

o Overview map cive Theme:
Show Dveryi Active Th CHTR34 i

3. Drag the red box map insde the Overview Window to pan the Map View.

4. Toremove the Overview Map, uncheck the Overview option from the view menu.
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CHAPTER 4

Classifying data

ArcExplorer alows you to create maps based on tabular values like
country name, well depth, or property value. Using this so-called
"attribute data" to code mapsis known as thematic mapping. You can
label themes, classify the features on a specific type, or classify the
features by anumeric value. Click the Theme Propertiestool, or double
click athemein the Loca Table of Contentsto bring up the Theme
Propertieswindow for that theme. (Y ou can change the display of
WWW data, too, but only after downloading it to aloca Map View.) In
the Theme Properties dialog box you have four choicesfor displaying
data: single symbol, unique values, class breaks, and labels.

Single symbol maps

The Single symbol classification displays dl the features in the theme with the same
color and style. Thisisthe default setting.

Theme properties for COUNTIES

Theme name: |CE|UNTIES

Classification Dptians——
& Single Sumbal The spmbol classification displaps all the features in the theme with
|n.ge L the same color and style. This is the default renderer. The basic

Urigque % alues symbol properties are shown here. Click Other Symbol Properties. ..
[map by type) to update moare symbol properties.
Class breaks
[map by amount] Calar: -

" Labels

Other syrbal properties. ..

ak. Cahcel Apply

To create a Single Symbol Map
1. Choose Single symbol from the list of classification options.
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2. Click the Color box to bring up acolor palette and change the color to one of the
available choices or create acustom color.

3. Click the Style drop down menu to change thefill pattern. The available choices
will differ depending on whether your dataiis point, line, or polygon.

Enter alinewidth. Click Other symbol properties to change theline color.

To make your changesto the display click Apply or click OK. Apply does not
dismissthe dialog box; OK does.

Unique value maps
The Unique va ues classification draws features by applying a different color to each

unique valuein the specified field. (In the example shown below, amap of U.S.
Countieswill draw the counties from each state in a separate color.)

Theme properties for COUMTIES E

Theme narne: |I:DUNTIES

Clazzification Dptions

¢ Gingle Symbol The value map clazsification draws features by applying a symbol to
; each unique walue of the specified figld. First, zelect a field. Arbitrary
¢ Unique Values spmbols will be set. Click on the symbol in the: legend to madify it.
[map by type]
e Class breaks
[map by amoLint] Dizcrete values and symbals: Field:
0 Labels COUNTIES [STATE_NAME =l
Alsbama
B Alaska
B Aiizona ¥
Arkanzas
B California
B Colorada
Conmecticut »

ak Cancel Apply

To create a Unique values map
1. Choose Unique Vauesfrom thelist of Classfication Options.
2. Click onthe Field drop down menu and select afield (e.g., STATE_NAME).

ArcExplorer automatically assigns random colorsto each unique classification. Y ou

can change the color for any value by clicking on the color box itsalf.

3. Check the Remove Outline box if you want polygons drawn with no outline. (This
is useful when you have lots of small polygon features.)

4. Click Apply or OK.

5. Click the Clear Thematic Classification tool ﬂ to remove the classification from
the active theme and return to the single symbol mode.

To highlight features from the legend

Once you've set up a Unique Vaues map, you can click on acolored box in the legend to

highlight the corresponding features on the map. Use the Clear Selection Highlight
button to remove the highlight from the map.
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Class break maps

The class breaks option uses quantile classification to create graduated color maps. A
different color is applied to each category of values from whichever field in the database
you specify. Each classisassigned as close to the same number of features as possible.
(The steps outlined bel ow demonstrate how to create shaded polygon maps; the same
technique could be used to create graduated symbol sizesin a point theme.)

Theme properties for COUNTIES E

Theme name:lEDLINTIES

Clazssification Options

2 The clazz breaks clazsification lets pou apply symbaols to a set of
. S|n.gle silo) digcrete values. First, specify the field and number of breaks. vou
[UnlCIUbB Valu?s can apply a color ramp and symbol zize relationship .
map by type
- Class breaks Murneic field:
" fmap by amoun) [PoP1ase | Mumberef 5~ <]
C Lahels Class breaks:
COUMTIES Cal _
B =870 e
W 2a7500 Start I
B 17.378.00- Erd -
B 3301800
W 7o3e1.00- r

QK Cancel Apply

To create a class breaks map
1. Choose Class breaksfrom thelist of Classification Options.

2. Pick avariable from the Numeric field drop down list. Thisfield containsthe vaues
that will be mapped.

3. Choose how many discrete breaks you want in your classification from the drop
down list.

4. Click onthe Start color and End color boxes to change the starting and ending colors
for your color ramp.

5. Check the Remove Outline box if you want polygons drawn with no outline. (This
is useful when you have lots of small polygon features.)

6. Click Apply to change the color ramp.
Click OK to dismissthe Theme Properties dialog.

8.  Click the Clear Thematic Classification tool ﬁ to remove the classification from
the active theme and return to the single symbol mode.
To highlight features from the legend

Once you've set up a Class Breaks map, you can click on a colored box in the legend to
highlight the corresponding features on the map. Use the Clear Selection Highlight
button to remove the highlight from the map.
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Label maps

The Labels option draws maps that are labeled with information from a specified text
field in the database.

To labd atheme that’s been classified as Unique Value or Class Breaks, smply add that
theme to the Table of Contents twice, then set one up as the classified theme and the
other asthe label theme. Make sure the label themeison top in the Table of Contents so
that your labels draw on top of the map features and that "Draw features' is unchecked.

Layer properties for ae_world E

— Clazsification Options—
) The label classification draws text from the specified field besides features.
e Single Symbol First, select a text field. You can optionally change the font, color,
alighment and angle. If you check Draw features, then the features will be
 Walue map
 Class breaks Text figld:
INAME - l Color: N
& Lahels
Font: Ratation angle: ID 'l
M5 Sans Seiif I~ Allow Duplicates
¥ Draw features
‘Wertical alignment: Horizontal alignmment:
IAIign top j IAIign right j

Cancel | Apply |

To create a label map

1. ChooseLabelsfromthelist of classification options.

2. SdectaText field from the drop down list.

3. Click the Font box to change the font style, Size, or color.
4

Usethe verticad and horizontal alignment toolsto control the label position relative
to the center of the feature being labeled.

5. Enter avaluefrom 0to 360 if you wish to rotate the labels. 0 isdefault and resultsin
aline of normal horizontal text.

6. Click the Allow Duplicates box off if you want alabel to appear only once even if
there is more than one feature with the same name.

7. Unclick the Draw features box if you wish to see only the labels and not the actual
features themselves.

8. Click Apply and OK to dismissthe dia og box.

9. Click the Clear Thematic Classification tool ﬂ to remove the classification from
the active theme and return to the single symbol mode.
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CHAPTER 5

Exploring data

In the previous chapter, you saw how ArcExplorer can be used to
visualize patternsin your data. Y ou can also use ArcExplorer to study
your data by asking it to show you map features that meet certain criteria.
Thisis accomplished with ArcExplorer identify, find, and query tools.

Identifying features by pointing

The Identify tool alows you to point at afeature on the map to bring up information
about it.

To identify a feature in an ArcExplorer

1

Click on athemein the Local table of contentsto makeit active.

Click on the Identify tool @
Move the cursor over the view and click on the map feature you wish to identify.
The Identify Results window appearslisting datafrom all the fieldsin the database.

If more than one feature was identified, ArcExplorer will tell you how many and let
you pick the one you want to see from the Feature drop down lig.

Identify Results H
Location:
1 feature found
Feature:

Califarmia j
Attributes:

STATE_MAME = Califormia
SUB_REGION = Pacific
STATE_ABBR =Ca&
Featureld = 24

POP19390 = 29760021
STATE_FIPS = 0R

AREA = 157774187
POP1996 = 32218713

Theme: States
Shape Type: Folygon

5. Click the Close button to dismissthe Identify Results window.
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Finding features by name (non numerical
search)

TheFind tool alows you to find specifically named features from a GI S database. The
Find command only works on text strings. To search for festures according to a numeric
value, usethe Query Builder.

To find a specific feature by name

1. Click onathemeintheLocal table of contentsto makeit active.

2. Click onthe Find Featurestool ﬂ to bring up the Find Features dialog box.

Find Features E

1. Enter name of what you want to find
ILDS Angeles j

2. Select a zearch type
& AnpPatof Field ¢ ‘Whole Field ™ Start of Field

3. Chooge which themes to zearch

_ Find |

4. Pick a feature 1 matches found
| Feature | W alue
MAME Loz Angeles
1] | H

5. Select the operation to perform

Highlight ER—— Zoem |

3. Fill out the form as shown. Press Find after choosing which themes or themesto
search.

4. PressHighlight to see the festure flash on the view; press the Pan To button to pan
the display to the found feature; pressthe Zoom To button to zoom the view into the
found feature.

5. Sort thefind results by any field by pressing the title of that column.
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Finding features with the Query Builder

Building a query isa powerful way to select featuresin ArcExplorer because a query can
include multiple attributes, operators, and calculations. For example, the query below
asksto see dl states that had a 1990 population of over 1,000,000. Additionally, this
query could be modified to select states with a surface area of under 10,000 square miles
as such: "POP1990>1000000 and AREA<10000".

Note: Thesze of your database will affect how quickly ArcExplorer performs the query.
For instance, a query against 3140 U.S. Countieswill move more dowly than asimilar
query against 50 states. Also, asking ArcExplorer to show dl the attributes of the
selected features will further dow down the process.

To query the active theme in ArcExplorer

1. Pressthe Query tool ﬂ to bring up the Query Builder. Select afield to query.

Query Builder - STATES ]

Select a Field: Values:
11123416

< = >

AREA
POP1990 =) % | s
POP1936 and | or | like
STATE_ABER

STATE_FIPS Statiztics |
STATE_MAME 121430
SUB_REGION 1254465 ;l

[FOF1350 >1000000]
=] | - | Show Attributes of Selected Features

Query results: 43 selected

AREA | STATE_MAME | STATE_FIPS | sup_=|
56297.954 (linois 17 EMLC
57896.367 Michigan 2 EMLC
55629196 Gieorgia 13 Sal
£351.435 Hawai 15 Facifi
B728E.878 wazhington 53 Facifii
11 | bi

Selected Recard
Highlight | Far | Zoom | Highlight Hesultsl Zoom to Hesultsl

2. Click onthe operators, or type aquery into the query window.

3. PressExecute. All the featuresthat meet the query definition will appear in the
Query Resultswindow. (The Query Builder will only list the first 2,000 records
found that meet the criteria.)

Working with Query results

1. PresstheHighlight Results button to highlight all the featuresin the Map View that
met the query. Usethe Zoom to Results button to zoom in on just those features.

2. Pick asinglerecord from the results window and press Highlight to flash the feature.
Press Pan or Zoom to see that feature in the Map View.

3. Sort the query results according to atext field by pressing thetitle of that column.
(Sorting the query results only works on al phanumeric fields; if you sort a numeric
field you'll get the wrong result.)

4. Pressthe Clear Results button X! to clear the Query Resultswindow.
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Generating summary statistics

Once you've selected a st of features with the Query Builder, you can also generate
summary statistics on acertain field in the database for just those selected records. (The
same process works on the full database if no records have been selected with the Query
Builder.)

To generate summary statistics

1. Inthe Query Builder, pressthe Statistics button.

2. Sdectthefield for which you want to generate statisticsfrom thelist. (Worksonly
on numeric fields))

Select a field to get Statistics

Select a Field:

Cancel

IE
=)

™ Use Query Results?

3. By default, ArcExplorer will generate statistics for all records; put acheck mark next
to Use Query Resultsif you want statistics on just the query results.

4. Thesummary statistics will appear in the window at the lower part of the Query
Builder:

Query Builder - Counties [=]

Select a Field: Walues:

<3 <=

STATE_FIPS and| or | ke
STATE_MNAME
%_COORD

Y_COORD

[ POP1336 »>1000000 Clear Query
B X | Show Attributes of Selected Features W

Query results: 33 selected

Item | Value |
Count 3140

Max 9255048

Mean 8440E.0461 78344
Hin 27

StdDev 276344.213844807
Sum 265037497

To save summary statistics or the results of a query to an ASCII file

Pressthe Save Results button E above the Query Results window to create anew file.
Name the new file and press Save. (At this point the file could be openedin a
preadsheet or word processing program to create areport or conduct further analysis.)

Thisiswhat adelimited ASCII text file lookslike:

NAME|STATE|STATE_FIPS|CNTY_FIPS|FIPS|AREA|POP1990|POP1996[X_COORD|Y_COORD
King|53|033|53033|2188.8703|1507319|1645096|-121.74214|47.43013
Hennepin|27]053|27053|606.3642|1032431|1064043|-93.46867|45.01848
Middlesex|25|017|25017|847.526/1398468]|1407602|-71.46432|42.44005
Cuyahoga|39|035|39035]469.4677|1412140|1396483|-81.66462|41.4519
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CHAPTER 6

Printing, copying, and saving

ArcExplorer includestoolsthat alow you to create hard-copy output,
copy your maps to other applications, and save your work for later use.

Printing a map

ArcExplorer provides asimple map layout in landscape (horizontal) format. The layout
includes anorth arrow, legend, title text, date, map view, and an optiond scale bar (the
scale bar must be present in the view in order for it to appear on thefinal layout). If you
have too many themes, or if the classification has too many categories, the legend will not
fit onto the page. (If you want to add customized legends, graphics, additional text, or
multiple viewsto your maps, you'll need a product like ArcView GISto do thejob.) The
print function will work with any Windows supported printer.

To print a map of your ArcExplorer view

1. Setthetheme display characteristics and zoom in so that the map in the Explorer
view looksjust the way you want it to ook on paper.

Choose Print from the File menu, or pressthe Print tool @ .

3. ArcExplorer will prompt you to enter atitle for the map. Type some text and press
OK to send the map to your Windows printer. Y ou can choose the Set Printer
Properties to change printers or to access other printer options.

Copying map views for use in other applications

Sometimes you may want to copy the image of amap view for use in another Windows
application (like aword processor or adrawing program). ArcExplorer makesit easy to
create a graphic image from your view.

To create a graphic from an ArcExplorer view

1. Setthetheme display characteristics and zoom in so that the map in the Explorer
view looks just the way you want it.

2. Pull down the Edit menu, or right click in the Explorer view, to access the Copy to
Clipboard and Copy to File commands.

3. Choose Copy to Clipboard if you plan to go directly into another Windows program
and pastetheimagein directly. Choose Copy to Fileif you want to create a
permanent file to use a any timein the future. If you do this, ArcExplorer will
prompt you to name the new file.

Use the BM P (Windows Bitmap) option if the image hasfilled areas. Usethe EMF
(Enhanced Met&file) option if the map has only linesand nofills.
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Saving your work in ArcExplorer

ArcExplorer saves projectsin .aep files. An ArcExplorer project savesthe Map Display
properties, whether themes are turned on or off, the map extent, view properties, any

classification or labels applied to themes, and any scale factors you may have set. When
you create an .aep file, you're not changing or altering the base data in any way.

To save an ArcExplorer project

1. Choose Save from the File menu, or press the Sa\;ﬂbol
2. Name your ArcExplorer project.

3. Press OK.

Note: Unlike ArcView GIS, when opening a project ArcExplorer matl prompt you

for any data that may have moved since you last saved the project. Instead, it will warn
you with a message that there was an error trying to open a theme and then it will restore
the view with the themes that it could find.
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CHAPTER 7

Troubleshooting

The following questions should address most of the problems you might
encounter using Arcexplorer. If you can't find the answer to your
question here, please refer to ESRI’s ArcExplorer Web ste at
http://www.esri.com/arcexplorer for online support, discussion forums,
and other late-breaking information.

| can’t download the software.

ArcExplorer isavailable for free downloads from ESRI’s ArcExplorer Web site. You
may have trouble downloading the ingtallation file because your Internet Service Provider
(ISP) limits the amount of data you can download or your connection to the Internet is
dow (28.8 modems may require an hour or more to download the software). If you have
difficulty downloading the software, you can obtain ArcExplorer on CD—ROM by
calling ESRI at 1-800-GIS-XPRT.

| can't install the software.

Make sure that your system meets the requirements listed under System Requirementsin
this document. Do you have enough room on the hard drive where you'd like to ingtall
ArcExplorer? If you're running Windows NT, you must have adminigtrative rights to
your computer when installing ArcExplorer. Without these rights, the installation will
terminate and warn you. If you are not sureif you have these rights or how to obtain
them, check with your system administrator.

In my class break map, why does my first class have -99 as a value?

Sometimes geographic dataisincomplete. For example, a Gl S database may include
political boundariesfor countries, but it may not have complete attribute information for
every feature represented. Asaresult, database developers must use acode for missing
information. These developers often use "-99" as this code for "no data."

How do | label a map that has a value or class break map?

Add the same theme to your legend twice. Set one theme with a value or class break
map. Label the second theme as you like, uncheck the Draw Features box, and press the
Apply button. You should be able to see the second theme’s labels on top of the first
theme'’s colored shapes, provided that the labeled theme is listed on top of the other
theme in the table of contents. You can also set the maximum scale factor so that the
labels will only appear when the user zooms in to a certain scale. This helps to reduce
cluttered labels on the map when zoomed to a small scale.
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When | click with the zoom out tool, the map zooms out too far.

Chances are that you didn't ssimply click once. Y ou may have clicked and moved the
mouse asmall fraction, thereby defining asmall rectangle before releasing the mouse
button. If you do this, ArcExplorer will zoom out very far. To avoid this, ensure that you
click once without moving your mouse.

The WWW view doesn't fill the application window.

Initscurrent release, ArcExplorer only provides small sized maps from the WWW view.
Future releases may extend the functionality so that you can select one of three sizesfor
themaps. 1nthe meantime, you will often have the opportunity to download the dataand
view it a any sizefrom your local view.

The WWW view has a map, but it doesn't fill the window.

ArcExplorer requiresthat your display settings use small fonts. To change your setting,
select the Settings option in your Windows Start Menu, select Control Panel, and then
Display. From the Display Properties dial ogue, choose the Settings Tab. Change the
Font Size from Large Fontsto Small Fonts and press Apply. You may have to restart
your machine for the change to occur.

How can | make the screen stop redrawing if it is taking too long?

Enable the Escape key to interrupt the screen redraw in the Map Display Properties
window. (Seepage14.)

ArcExplorer can't find some data because the data has moved. Is there a
way to prevent this?

Yes. Set up relative pahnamesin your .aep file. Use atext editor to open thefileand
locate dl the map layers and their associated pathnames. The pathnames are the firgt line
after the[MAPLAY ERX] designation. Edit dl the pathnamesin your .aep file to enable
the project to restore on any machine.

An example of the critical text from an .agp fileis given below.

[MAPLAYER/]
WORK SPACE=E:\ESRI\dataltrails

Assume that your data is stored in the “DATA” directory in folders called “trails,”
“counties,” “rivers,” and “schools.”

WORKSPACE=E: \ ESRI\ DATA\ trai |l s
\counties
\rivers
\ school s

As long as the .aep file is stored in the “DATA” directory, you can edit the pathname in
the .aep file to read:

WORKSPACE=\trail s
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Whether the CD-ROM drive is named “d:” or “e:”, the .aep file will find the trails data

and display the project as you saved it. This is also useful if someone decides to load
your data onto one of their hard drives. If you store the .aep file in the same directory as
the data itself, you can edit the pathname to read:

WORKSPACE=\

In this case, the pathname contains only a single slash.

NOTE: If you save the project again, the pathnames will be restored to their entirety and
no longer be relative.
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CHAPTER 8

Frequently asked questions

The following questions should address most of the other questions you
might have about ArcExplorer and how it fitsinto the ESRI family of GIS
software products. Once again, for the very latest information on
ArcExplorer, refer to ESRI's ArcExplorer Web site located on the Internet
at http://www.esri.com/arcexplorer.

What other Web sites can | access to get data?

Currently there are only afew stesthat include the capability to serve datato
ArcExplorer viathe Internet. These sites have been built and are maintained by ESRI.
When the ArcExplorer Server extension isreleased soon, many user siteswill be
configured to deliver datato ArcExplorer clients. Eventudly we believe that there will be
alarge worldwide network of servers providing datato ArcExplorer clients.

How does the vector data get delivered?

The vector datais extracted by the server, compressed, and then shipped viathe Internet
to your ArcExplorer client, whereit is restored in standard shapefile format. The data can
be cached temporarily or stored at any location on disk.

Does ArcExplorer support drag and drop file functionality?

Yes. ArcExplorer uses OLE technology to alow you to grab a shapefile (*.shp) from
any Windows directory and drop it into the ArcExplorer view to add it asatheme.

Can I move the tool bars and menus around to suit my task at hand and
personal preferences?

Yes. Themenu bar and button bar are both docking elements, so you can reposition them
intheinterface by just clicking and dragging them around. Y ou can even undock them so
they're floating free anywhere in the application window. Double click a repositioned
tool or menu bar to return it to its original position.

What happens when I right click in the Map View?

You get access to the following tools in a pop up menu: Full View, Zoom in and out,
Pan, Identify, Find, and Query. (Pressing the Control key while right clicking the Map
View in WWW mode has the same effect.)

Can | have more than one ArcExplorer project open concurrently?

Yes, open as many new or saved ArcExplorer projects as you wish. A new ArcExplorer
application window will appear for each session.
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What are the supported image file formats?

Windows Bitmap - *.bmp, *.dib

TIFF (Tag Image File Format) - * .tif, * tff, *.tiff
ERDAS- *.gis, *.lan

BIL (Band interleaved by line) multiband images - * .bil
BIP (Band interleaved by pixel) multiband images - *.bip
BSQ (Band sequentia) multiband images - *.bsq
IMPELL RLC (Run-length compressed) files- *.rlc

Sun Ragterfiles- *.rs, *.ras, *.sun

How is ArcExplorer built?

ArcExplorer is built using MapObjects software. MapObjects alows peopleto build
their own custom GIS applications or add active mapping and geography to spreadsheets,
charts, documents, and more.

Check out http://www.esri.com/base/products'mapobj ectsmapobjects.html for more
information or call 1-800-GIS-XPRT.

Will ArcExplorer be available for a Macintosh or UNIX platform?

The technology with which ArcExplorer isbuilt is not currently supported by the
Macintosh or UNIX operating systems. However, future releases of ArcExplorer will
extend the current system to include additiona operating systems.

Does ArcExplorer support ARC/INFO annotation coverages?

Yes. ArcExplorer imports annotation layers as line themes. Add the annotation layer
and use the Theme Properties dialog to label the theme using the TEXT field name.
Uncheck “Draw Features” so that the lines don’t draw.

What about ESRI's .e00 export files for ARC/INFO coverages?

An .e00 ("E-zero-zero") fileisan ARC/INFO coverage converted into an ASCI| text file
intended for exchange between two ARC/INFO systems on different platforms. They are
not intended for compression, but have become popular as exchange files. In order to
convert an .e00 fileto an ARC/INFO coverage or ArcView GI S shapefile, you must have
ARC/INFO or the Import software distributed with ArcView GIS. You can aso
download the ESRI Workspace Trandator, afree utility that allows you to convert export
filesinto ARC/INFO workspaces. The Workspace Trandator aso alows you to convert
between PC ARC/INFO format coverages and ARC/INFO format workspaces. Check
www.esri.com for details on downloading the Workplace Trandator.
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Can | include project (.aep) files with the data | published on CD—-ROM?

Yes. If you decide to publish your data on CD—ROM and you choose to use ArcExplorer
as your data browser, you can use relative pathnames. In other words, regardless of
which drive letter the user has for the CD—ROM drive, the project file will find the data.
Also, if the user loads the data onto another drive, the project will still find the data.

My organization wants to publish our GIS data on CD-ROM. Can we use
ArcExplorer as the data browser?

Yes. You can use ArcExplorer as adata browser provided you agree to ESRI's license
agreement. Ultimately, ESRI wantsto make it easy for you to include ArcExplorer with
your data and the license reflects that.

Can | customize ArcExplorer for my organization or others?

No. ArcExplorer isadata browsing product, not a development tool. However, ESRI’s
staff can create similar applications quickly, adding or removing the tools you need.
ESRI can aso teach you how to create applications like ArcExplorer on your own.

To contract with ESRI for custom programming support, contact ESRI’s Implementation
Services at 909-793-2853 (telephone), 909-307-3014 (fax), or E-mail at
arcexp@esri.com, or write to Implementation Services, 380 New Y ork Street, Redlands,
CA 92373-8100.

Tolearn more about ESRI’straining courses, contact the ESRI Learning Center at 909-
793-2853 (telephone), 909-335-8233 (fax), or visit ESRI's Educational Services home
page at http://www.esri.com/baseltraining/training.html.
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APPENDIX

ArcExplorer User Interface
Quick Reference

The tool bars

Y ou can access most ArcExplorer functionality with the following tools. All of these
functions are also available through the menu bar. Thetoolswork in both Local and
WWW mode unless otherwise indicated.

E File/New

Opensanew ArcExplorer Window. 'Y ou can open as many ArcExplorer Windows at the
sametime as you want.

—u
g File/Open
Opensasaved ArcExplorer project (files with .aep extension).

E File/Save

Saves an ArcExplorer project asan .aepfile.

F,
E Close View

Removes all themes from the Table of Contents and returnsto an empty view (closes
Web map stein WWW mode).

E Add Themes

Adds one or more themesto the Table of Contentsand Map View. In WWW mode,
adds aWeb map site

% Print

Outputs a preformatted map layout on your default printer.

35



Toggle

Removes the Table of Contents and Overview Map from the ArcExplorer Window.
Press Toggle again to restore window to its origina state.

== Theme Properties (Local mode only)

Opensa dialog box where you can set the display characteristics of the active theme.

0
ﬂ Clear Thematic Classification (Local mode only)

Removes any classifications from the active theme.

:
@ Clear Sdlection Highlight

Clearsany highlighted featuresin the Map View. (Featuresare highlighted by clicking
on acolor box, line, or point in the legend.)

g Full View

Zoomsthe Map View to the full extent of al the themes.

gﬁ | Zoom to Active Themes (Local mode only)

Zoomsthe Map View to the extent of only the active theme.

ﬂ Zoom to Previous Extent

Returnsthe view to the last previous extent.

E ZoomIn

Zoomsin on the position you click or the box you drag onaview.

% Zoom Out

Zooms out from the position you click or the box you drag on aview.

& e

Pansthe Map View by dragging it in any direction with the Pan tool.
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ﬂ Pan West

Pansthe Map View to the west.

¥ s

Pansthe Map View to the south.

ﬂ Pan North

Pansthe Map View to the north.

ﬂPanEast

Pansthe Map View to the easl.

E | dentify

Pulls up the attributes of features in the active theme. Click on afeaturein the Map View;
an | dentify Results window will pop up.

ﬂ Find featuresin Active Themes (Local mode only)

Brings up the Find Feature dialog box to locate map features based on a string in atext

field. (Workson text fields only; use the Query Builder to find features based on numeric
values))

7
E Query Builder (Local mode only)

Brings up the Query Builder to construct a query on the active theme.

E Map Tips (Loca mMode only)

Brings up adialog box that dlowsyou to select afield. The datafor thisfield will then
be displayed for each feature on the map as you move the cursor on the screen.

g Cancel WWW request (WWW mode only)

Cancelsarequest sent for a download of WWW data.

é Retrieve Vector Data (WWW mode only)

Downloads a shapefile of the active theme.
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Menus

All of the functions found on the tool bars are a so accessible by pulling down the menu
Bar. Usethe shortcut keyslisted next to the menu choicesfor direct accessto those
functions.

JJEiIe Edt “iew Theme Toolz Help

D Mew Ctrl+M Owerview é} Fuall et ? Help Table of Cantents
‘= Open Chrl+01 Clear Overview E S Search for help on
EH save Chrl+5 Explarer View Q Zaom Out &¥ ESRIweb Site
1 Cloze View | Display ScaleBar 4™ Pan About
% Pr ScaleB ar Properties 3 0 | dertify
Tt = _ _
> e tap Dizplay Properties ﬂ B
3 i '&3 Luery Builder
v v
Copy (BMP]  Cti+C +: Add Theme Chilss
Copy [EMF] # Add SDE Theme Chrl+S
E Copy to Fils [BMP) 7 Remove Theme Ctrl+R
[l Copy to File [EMF) & Zoom To Theme Chiksz

Idze in Owverview kMap

Theme Properties Ctrl+P

4 & Clear Thematic Classification
‘¥ Clear Selection Highlight
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